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the exclusive liability of the manufacturer, AND IN LIEU OF ANY AND ALL OTHER WARRANTIES, 
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End User License Agreement
This End User License Agreement (“Agreement”) grants you the right to use the software con-

tained in this product (the “Software”) subject to the following restrictions: You may not: (i) copy 

the Software, except for archive purposes consistent with your standard archive procedures; (ii) 

transfer the Software to a third party apart from the entire product; (iii) modify, decompile, disas-

semble, reverse engineer or otherwise attempt to derive the source code of the Software; (iv) 

export the Software or underlying technology in contravention of applicable U.S. and foreign

export laws and regulations; and (v) use the Software other than in connection with operation of 

the product.

“LICENSOR'S SUPPLIERS DO NOT MAKE OR PASS ON TO END USER OR ANY OTHER THIRD PARTY, 

ANY EXPRESS, IMPLIED OR STATUTORY WARRANTY OR REPRESENTATION ON BEHALF OF SUCH 

SUPPLIERS, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF NON-INFRINGE-

MENT, TITLE, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.”



Important Precautions and Useful Information
This preface contains information that will help you understand and safely maintain MCE 
equipment. We strongly recommend you review this preface and read this manual before 
installing, adjusting, or maintaining Motion Control Engineering equipment. This preface dis-
cusses:

• Safety and Other Symbol Meanings

• In This Guide

Safety and Other Symbol Meanings

Danger
This manual symbol is used to alert you to procedures, instructions, or situations which, if not done 
properly, might result in personal injury or substantial equipment damage.

Caution
This manual symbol is used to alert you to procedures, instructions, or situations which, if not done 
properly, might result in equipment damage.

Note

This manual symbol is used to alert you to instructions or other immediately helpful information.

In This Manual:
This manual is the installation and operation guide for the iMonitor monitoring application. 
When viewed online as a pdf file, hyperlinks link to related topics and informational websites. 
The manual includes:

• Contents: Table of Contents. When viewed online as a pdf file, hyperlinks in the Contents 
link to the associated topic in the body of the manual.

• Section 1. iMonitor general description and installation instructions. 

• Section 2. Quick Start: Quick instructions for getting started using iMonitor. 

• Section 3. Reference: Detailed explanation of screen controls. 

• Index: Alphabetical index to help you find information in the manual. When viewed 
online as a pdf file, index entry page references are hyperlinks to the associated informa-
tion in the manual.
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1

• iMonitor
• Installation
• Establishing Connections
iMonitor
iMonitor
iMonitor is an elevator, escalator, or moving walk monitoring application that 
allows local or remote viewing and control of MCE transportation groups using a 
personal computer running the Windows XP operating system.  iMonitor connects 
to controllers though a local area network or remotely through internet/modem 
technology.

iMonitor provides a graphical representation of building transportation groups, allowing their 
activity and status to be quickly and easily viewed. The user defines any number of “Connection 
Sets.” Each Connection Set consists of up to fifty connections to transportation group dispatch-
ers selected by the user.

When working in iMonitor, the user simply clicks on a Connection Set which automatically 
establishes communication with all groups in the set and displays their associated hoistways 
and cars or steps/belts on the computer screen. Practical viewing limits are established by the 
speed of the connections and the size of the monitor viewing area.

Through iMonitor, you may register car and general, auxiliary, or special hall calls, control 
many group security functions, and enable or disable certain operating modes if these functions 
are supported by the controller with which you are communicating. There will be differences in 
the extent of control available depending on controller type.

Note

This manual describes all iMonitor software features. If you are connected to a controller other 
than an iControl, not all features will be supported by your controller.
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iMonitor
Installation
Installing iMonitor includes:

• Determining hardware requirements

• Installing monitor software

• Establishing connections

Determining Hardware Requirements
MCE iControl, Motion 4000, Motion 2000, and Motion 3000ES controllers are Ethernet ready 
from the factory. MCE IMC and PTC/PHC controllers require additional hardware.

• IMC (v4.0 and later): Requires an MC-USN (Universal Serial Networking) board and a 
power transformer. Kit available from MCE.

• PTC or PHC: Requires an MC-USN (Universal Serial Node) board, an MC-M2C (MCE to 
CAN bus converter) board, and a power transformer. Kit available from MCE.

If you want to connect to an IMC, PTC, or PHC controller, please contact MCE for the appropri-
ate kit and installation instructions.

Installing iMonitor Software
If you purchased your iMonitor PC through MCE, iMonitor has already been installed. If you 
need to install iMonitor software, make certain that the PC and monitor meet minimum 
requirements:

• 1GB or more RAM, 80GB or greater hard drive

• Microsoft Windows XP Service Pack 2 or greater

• Intel 1.6 gHz Core Duo Processor or equivalent

• CD-ROM, 10/100 Ethernet capable

• 1280 x 1024 capable monitor, 17” diagonal display minimum (* see note)

1. Uninstall any previous versions of iMonitor. (See Old Versions below.)
2. Insert the CD-ROM or download the iMonitor program and copy it to the computer 

desktop.

3. Open the iMonitor folder and double-click on the LaunchSetup.exe program.

4. Follow on-screen instructions.

Note

View Only: The View Only installation option will install a subset of iMonitor that allows view-
ing but does not allow control options to be exercised.

Old Versions
If you have an older version of iMonitor already installed on the computer, use the Add/
Remove Program function from the Windows Control Panel to remove it before installing new 
software.
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Establishing Local Connections
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Establishing Local Connections
The iMonitor PC may be connected to individual or group controllers locally or remotely 
through the internet or using a dial-up modem. Connection information for iControl is provided 
in this section. If you are connecting to a different controller type, follow the instructions 
included with the hardware interface kit or controller instruction manual.

MCE iControl Ethernet
MCE iCue elevator group controls use two local Ethernet networks. The first of these, the Sys-
tem network, is only used for immediate elevator traffic control. No PC or other non-iControl/
iCue connections may be made to this network. This network uses orange cabling to set it apart 
from the second, iView network (blue cabling).

The iView network provides the point of connection for both iView and other PC or network 
related equipment. You can identify the Ethernet switch for the iView network by checking:

• The switch is labeled “LAN.” Connections from the switch to the individual iControl eleva-
tors in the group are plugged into the #1 = LAN connection on the iControls.

• The iView PC for the group is connected to this switch.

• The connection from the switch to the iCue Group control is to the group control LAN con-
nection.

The factory-default TCP/IP information for an iCue/iControl elevator group is:

* The iView PC typically uses 192.168.191.101

The default Subnet Mask for all ports is 255.255.255.000.

The default Gateway for the #1 (LAN) is 192.168.191.254.

Authorization
Before iMonitor is allowed to view and control an iControl system, authorization for the connec-
tion must exist within the system to be monitored. If you attempt to connect to an unauthorized 
system, iMonitor will display an authorization required message. For iControl systems, authori-
zation is configured through the iView application:

1. Connect to the system to be monitored using iView.
2. iView/System/Remote Monitoring Authorization.

3. The Remote Monitoring Authorization screen displays a hardware key unique to the sys-
tem.

4. Contact MCE Customer Support at 916 463 9200 and provide them the hardware key.

5. MCE will provide you with an authorization code.

6. Enter the authorization code on the iView Remote Monitoring Authorization screen 

Table 1.1   System, LAN, & 3=PC TCP/IP Addresses

switch Group 
ID 

Group IP Primary 
& Backup Car ID Car IP System/Serial 

Hall Call Bus 1 - 4 Free

LAN 1 192.168.191.201-202 1-20 192.168.191.001-020 192.168.192.211-214 192.168.191.101-200*
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iMonitor
The illustration below shows a single, typical iCue/iControl group with a locally connected iMo-
nitor PC.

Figure 1.1   Typical iControl LAN Connections, Elevator Group 1

192.168.191.1

CAR A

192.168.191.2

CAR B

192.168.191.3

CAR C

192.168.191.4

CAR D

192.168.191.5

CAR E

GROUP 1 ETHERNET ADDRESS EXAMPLES
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192
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192
LAN SWITCH

iCue Group Controller 

.168.191.101 

.255.255.0       Subnet Mask 

.168.191.254   Gateway 

192.168.191.102 

255.255.255.0       Subnet Mask 

192.168.191.254   Gateway 

PC used for LAN Connection PC used for iMonitor/iReport Client
iView, LAN 

BLUE CABLES 

iCue SYSTEM 

192.168.192.201 

255.255.255.0     Subnet Mask 
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iCue LAN 

192.168.191.201 

255.255.255.0     Subnet Mask 

192.168.191.254  Gateway 
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iMonitor
iControl Local Connection
Local connections are those not requiring a VPN.

One Group
The following illustration shows a same-site iMonitor installation for a single group.

Figure 1.2   Local Connection to Single Group

Restrictions
• No single Ethernet cable may be longer than 100m (330 feet).

• If any single cable run will exceed 100m, an Ethernet hyperextender or fiber-optic to 
Ethernet converters must be used.

• All IP addresses on an interconnected network must be unique.

• Use shielded CAT 5e or CAT 6 STP (shielded twisted pair) cable and follow all manufac-
turer recommendations.

iControl iControl iControl

iMonitor/iReport Client PCiReport Server PC

LAN Switch

Switch

iCue
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Multiple Machine Rooms / Dedicated Elevator LAN
Figure 1.3   Multiple Machine Rooms / Dedicated Elevator LAN

Restrictions
As with single group connections.

iControl iControl iControl

iCue

LAN Switch

iMonitor Switch

iControl iControl iControl

iCue

LAN Switch

iControl iControl iControl

iCue

LAN Switch

Mid Rise Group

High Rise Group

Low Rise Group

iMonitor/iReport Client PCiReport Server PC
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iMonitor
Multiple Machine Rooms with Existing Building LAN
Figure 1.4   Multiple Machine Rooms Through Building LAN

High Rise Group

iControl iControl iControl

iCue

LAN Switch Building LAN

iControl iControl iControl

iCue

LAN Switch

iControl iControl iControl

iCue

LAN Switch

Mid Rise Group

Low Rise Group

iMonitor / iReport Client PCiReport Server PC
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Restrictions
In the example above, each group LAN switch is connected to a cable drop or Ethernet port 
located in the machine room. Each machine room and the iMonitor station should be “cross-
connected” by the building IT department. It is good practice to isolate the elevator network on 
its own VLAN if practical.

To facilitate this type of connectivity, each device connected to the network needs a static IP 
address:

• iBox

• iCue PC

• iView PC

• iMonitor PC

• iReport Server PC

• Motion 2000 hydraulic control

• Motion 4000 traction control

• MC-USN (Ethernet adaptor used in IMC and HMC controllers)

The building IT department should provide a static IP address for each device. DHCP can be 
used for the iMonitor / iReport Client PC only. Please obtain the following from the building IT 
department:

• IP address

• Subnet mask

• Gateway

Enter the address information into the LAN address of each iBox, as well as the LAN address of 
each iCue. Also change the IP address for each iView, iMonitor / iReport Client, and iReport 
Server PC.
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iMonitor
Two or More Buildings
In the example below, Ethernet cables are run from the LAN switches of the groups down to a 
switch in the lobby. iMonitor / iReport Client and iReport Server PCs are also connected to the 
lobby switch. Finally, the lobby switches in each building are connected to one another through 
a fiber optic link.

Figure 1.5   Two or More Buildings 

BUILDING 1 BUILDING 2

iControl iControl iControl
iCue

LAN Switch LAN Switch

SwitchSwitch

Optical

Fiber

iControl iControl iControl
iCue

LAN Switch

iControl iControl iControl
iCue

LAN Switch

iMonitor / iReport Client PCiReport Server

iCue

iCue

iCue

iControl iControl iControl

iControl iControl iControl

iControl iControl iControl
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Remote Connection
If iMonitor is to be installed at a remote location, a high-speed internet connection and a VPN 
router are required. 

Figure 1.6   Remote Connection using a DSL Modem and a VPN Router

iControl iControl iControl
iCue

LAN Switch

iControl iControl iControl
iCue

LAN Switch

iControl iControl iControl
iCue

LAN Switch

Switch

VPN Router

iReport Server iMonitor / iReport Client PC

Remote PC

(iMonitor/iReport/iView)

DSL

DSL

Internet
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• iMonitor
• iMonitor Quick Start
Quick Start
2

iMonitor
iMonitor is a straightforward, graphical user interface. This manual section pro-
vides a quick tour of iMonitor with high level explanations of functionality. For 
additional detail, refer to Section 3.

• iMonitor Quick Start
• Create a Connection Set

• Monitor a Set
• Detailed View
• Multiple Hoistway View
• Campus View
• iLobby 
• Register Calls
• Security
• Remote Control Menu
• Diagnostics
• Tools Menu
• Help Menu

Note

iMonitor is functional with both current and older group controllers. This manual documents 
the screen appearance and functionality of iMonitor connected to a current release controller. If 
you are connecting to an older controller, all of the capabilities documented here may not be 
available and screen appearances and controls may be different.
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Quick Start
iMonitor Quick Start

Note

Before iMonitor can access a controller or group, authorization may need to be granted by the 
controller or group. Refer to the controller or group control manual for information. For exam-
ple, in iView, access is granted through the System Configuration, Remote Monitoring Authori-
zation tab. 

• Double-click the iMonitor desktop icon to launch the application .

• If iMonitor has not been previously launched and set up, the first screen you see will be the 
basic desktop.

Note

If iMonitor has been previously set up, it will open displaying a list of Connection Sets to choose 
from or with an active Connection Set live display if the “Start with last set” option has been 
selected from the Tools menu.
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iMonitor Quick Start

2

Create a Connection Set
iMonitor lets you create “Connection Sets.” Each Connection Set can contain connections to as 
many as fifty different elevator groups. When a Connection Set is opened, information about all 
the groups it contains will be displayed. Please refer to “Connections” on page 3-5 for detailed 
information about this screen.

• Select Connection Set/New under the File menu.

The Connection Set pane will appear (empty at first):

• Enter a logical name and the IP address for each group you add, select the hardware type 
(PC or iBox), click OK, give the set a name, and save it. (Repeat to create more sets if 
needed.)

• Primary Connections are primary group controllers. One for each group.

• Alternate Connections are elevator controllers or group dispatchers capable of taking over 
dispatching should the primary dispatcher fail.

• When you connect to a previously configured group, previously configured alternate con-
trols in the group are listed in the Alternate Connections area. Please refer to “Alternate 
Connections” on page 3-7 for more information.
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Quick Start
Monitor a Set
• Select Open from the File menu.

• In the dialog that appears, double-click on the set you want to view.

The selected set will appear in the last active display mode. You can switch between views using 
the five buttons next to the menus. 

Note

If an authorization required message appears when you attempt to connect, the system you are 
accessing needs authorization to allow the connection. Please refer to “Authorization” on 
page 1-3.

Overview Multiple Hoistway

DetailedCampus 
view

Lobby View
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iMonitor Quick Start

2

Overview
The elevator Overview display is shown below.

Per car, this screen provides:

* Group cars may occasionally operate in a mode that requires they be dispatched inde-
pendently. For example, cars on Swing service, Independent Service, etc. are not 
assigned calls by the Group while operating “independently.”

Group Name

Group Status Message

Group connection (to iMonitor) 
indicator

Car connection to group 
indicator

Group dispatched = Lighted
Independent* = Dark

Current floor

Preferred direction of travel

Operating mode

Live door position display
(Rear doors behind in blue if 
present)

Live travel direction 
indicator

Car Identifier

Car/Group Connection status
Alarm indication
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Quick Start
Escalator Overview
The escalator Overview screen is shown below. As with elevators, animated graphics indicate 
activity of escalator steps and position indication. Escalators will also indicate alarm conditions.

Group connection status
(disconnected = broken arrow)
Group connection status
(disconnected = broken arrow)

Controller to group connection,
Controller identification/label

Current run direction

Current run status

Current PI indication
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iMonitor Quick Start

2

Detailed View
• Select Detailed View/Group Name from the View menu:

Door status
Orange = front
Blue = rear

Call type, next destination, 
ETA information. Please 
refer to “Detailed View 
Explanation” on page 3-12.

Emergency power, Seismic 
status, Load weigher, Swing 
operation status indicators

Preferred direction of travel
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Quick Start
Escalator Detailed View
The escalator detailed view is shown below.

Primary safety string condition

Component speeds reported in pulses per minute by the 
primary escalator control board

Secondary safety string condition

Component speeds reported in pulses per minute by the 
secondary escalator control board

Drive type (Wye/Delta, VVVF)

Drive alarm bell status

Drive chain condition

Earthquake/seismic indicator status

Motor overheat indicator status

Smoke detector status
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iMonitor Quick Start

2

Multiple Hoistway Display
• Select Multiple Hoistway Display/Group Name from the View menu:

Please refer to “Multiple Hoistway View Explanation” on page 3-14 for detailed information.
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Quick Start
Campus View
The campus/site view provides a three-dimensional overview of an entire site (college campus, 
manufacturing cluster, airport buildings, etc.). Individual building transportation controllers 
are visible in approximation of their actual position. If a unit is not operating in normal mode, it 
will be reflected in the display. Clicking on any unit will open a dialog detailing unit status.

• To initially activate campus view, select Campus/Open from the File menu:

• A dialog will open, listing currently configured sites and allowing you to edit them if 
needed. Select the site you want and a preview will be displayed.

• Click Open.

Note

Campus view requires custom work to produce three-dimensional site maps of your facility. If 
you would like campus views in your iMonitor, please contact MCE.
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iMonitor Quick Start

2

The site view may range from a simple three-dimensional building cluster to a more detailed 
view depending upon the initial order conditions. Sites are best viewed on large (32-inch) mon-
itors at 1360 x 768 pixel resolution. A live site example is shown below.

This example is of a site with multiple escalator controls. Any of the escalator icons may be 
clicked to display more detail. Simply pausing the computer mouse over a unit will display 
abbreviated information in a pop-up window. An escalator dialog example is shown below.

Within Campus View
Once you have initiated the site/campus view, the Overview and Detailed View buttons will 
allow you to access controls just as in standard iMonitor view.
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Quick Start
Lobby View
The Lobby View is designed to be displayed on a wide, flat panel display in the building lobby. It 
connects to and graphically displays the status and movement of a single elevator group.

• Select View/Lobby View/Group name
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iMonitor Quick Start

2

Register Elevator Calls
You may register an elevator car call while viewing cars on any of the “view” displays. Click the 
call register button to begin. 

The call-type tabs (Hall calls, Car calls, etc.) will display the calls available for the selected 
group.

Hall Calls 
• Pick a Group.

• Pick a call type.

• Pick a floor number.

Note

You can register multiple hall calls if desired.
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Quick Start
Car Calls
• Pick a group.

• Pick a car.

• Pick front or rear call panel.

• Pick a floor.

Note

You can register multiple calls if desired.
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Remote Control

2

Remote Control
The Remote Control menu provides access to security, group, group timers, car recall, car set-
tings, remote outputs, and diagnostic outputs screens.

Elevator Security
iMonitor allows you to restrict elevator travel through the building by controlling hall and car 
call registration to an elevator group. Access to security settings beyond viewing general status 
is restricted to authorized users. There are two user classes, manager and technician. The man-
ager is allowed to set up and edit passwords, the technician is not. To log on:

1. Select Security/Group name from the Security menu. 
2. Click on the Logon button at the bottom of the 

screen. 

3. Enter the manager or technician password. (Fac-
tory default passwords are “manager” for manager 
logon and “technician” for technician logon.)

4. Click OK. Menus that were previously grayed-out 
will become available. 

Status
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Quick Start
The Status screen provides an overview of currently active security settings.

• Master security: 

• Active: Lights if any security mode is active.

• Hardware override: Lights if security has been overridden by a switch input.

• Software override: Lights if security has been overridden by a software selection.

• Activate button: Activates software security override.

• Active configuration:

• Display: Currently active security configuration.

• Hardware configuration: Lights if configuration activated by hardware switch.

• Software configuration: Lights if configuration activated by software switch.

• Timed configuration: Lights if configuration activated by system timer.

Note

Timers are configured through the Timer Tables screen. Please refer to your iControl User 
Guide.

• Hall call security overrides:

• Enable 1: Lights if the hall call input override #1 switch is closed.

• Enable 2: Lights if the hall call input override #2 switch is closed.

• Car call security overrides: (two LEDs per car)

• Car “x”: Two methods of car call security are provided (i.e., card reader and key 
switch). If one is overridden, an LED will light. If the second is overridden, the second 
LED will light.

Configuration 

This screen allows you to enable manual or timed assignment of security configurations. To set 
a security configuration manually:

1. Select Manual assignment.

2. Set the desired configuration in the drop-down list.

3. Click Send.

To enable assignment by timer setting:

1. Select Timed assignment.

2. Click Send.

Allows you to enable or disable the 
hardware security override 
switches.
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Remote Control

2

Manage Passwords

You must be logged on as the manager:
1. Click on the Manage Passwords menu listing.

2. Click on Set Pwd to open the dialog.

3. Select the User class (Manager or Technician) to set the password for.

4. Enter the password. (Double-check to make sure it is what you intended.)

5. Click OK.

Note

If you forget the password, locate the job number and/or serial number of the group controller 
and contact MCE Technical Support at 916 463 9200.

Initially, select the “manager” class 
and use the password “manager.”

During your initial access, set up 
passwords appropriately.
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Quick Start
Hall Calls
Hall Call security allows you to place two different kinds of restrictions:

• Per-Floor Security: Places restrictions on hall call riser access on a per-floor basis.

• Per-Car: Specifies which cars may stop at particular floors.

Per-Floor Security      Hall calls may be Unlocked, Locked, or Secured:

• Unlock: Unrestricted access. Calls may be registered.

• Locked: No access. Calls may not be registered.

• Secure: Access is restricted to authorized passengers. Calls may be registered after proper 
authorization (i.e., card reader, key switch, or code entry).

To set hall call restrictions:

1. Select Per-Floor Security. 

2. Set the Security input latch time. (Number of seconds before authorization times out.)

3. Select the security configuration to which the hall call restrictions apply.

4. Set whether parking will be allowed at a secured hall call or partially secured floor.

5. For the hall call type (i.e., Main, Auxiliary, CFSS) and location (Front/Rear), click in the 
table at the floor and direction (up/down) to be set.

6. In the selection list that appears, select the desired security condition (Unlock/Lock/
Secure).
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Remote Control

2

7. If Secure is selected, chose the combination of authorizing inputs (i.e., key switch 
(enable one), card lock (enable two) required to enter the call.

8. Scroll down if needed; click Send.

Alternative Selection      

• Click in a Floor box to select all calls on that floor. Or, click in a Riser box to select all calls 
for that riser.

• Choose the desired setting.
• Click OK to set all selected calls the same.

Or,

• Click and drag in a column or row to make multiple selections.
• Click Set Selection.
• Choose setting and click OK to set all selected calls the same.

Enable 1 and 2

Enable 1 or 2

Enable 1 only

Enable 2 only
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Quick Start
Per-Car Lockout      On a per-car, per-floor, per-direction basis, allows you to determine 
which cars may respond to any hall call type.

1. Select a call type.
2. For any car, click in a front/rear, up/down box.

3. Unlock to allow the car to respond. Lock to prevent the car from responding.

4. Click Send.

Alternative Selection      

• Click in a Car box to select all floors and directions. Or, click in a Riser box to select all calls 
for that riser.

• Choose the desired setting.
• Click OK to set all selected calls the same.

Or,

• Click and drag in a column or row to make multiple selections.
• Click Set Selection.
• Choose setting and click OK to set all selected calls the same.
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Car Calls/Passcodes
This screen allows you to set password length.
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Quick Start
Car Calls/Configuration
Car calls may be Unlocked, Locked, or Secured:

• Unlock: Unrestricted access. Calls may be registered.

• Lock: No access. Calls may not be registered.

• Secure: Access is restricted to authorized passengers. Calls may be registered after proper 
authorization (i.e., card reader, key switch, or code entry).

To set car call restrictions:

1. Select Car Calls/Configuration.

2. For the car and car call type (front/rear), click in the table at the floor and car panel 
location (front/rear) to be set.

3. In the selection list that appears, select the desired security condition (Unlock/Locked/
Secure).

4. If you choose Secure, select method of authorization.

5. Click OK. Click Send.

Click here to select all 
floors, cars, and calls in 
group.

Click here to select all 
front/rear calls for this 
car.

Click here to select all 
cars and calls for this 
floor.

Click here to select this 
car, this call, this floor.
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2

Alternatively:

• Click and drag to select multiple floors and calls or click in one of the auto-select areas 
shown in the illustration above.

• Click Set Selection and choose setting. Click Send.

Symbol Keys      The illustration below explains car call security symbols:

Enable 1 only

Enable 2 only

COP Code Entry No line between symbols 
means AND (all are 
required)

Line between symbols 
means OR (one of dis-
played methods 
required)
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Quick Start
Car Calls/Mode Override
On a per floor, per configuration, per car panel, per authorizing signal basis, you can allow a 
security authorization typically required to place a car call to be overridden when the car is 
operating in a selected mode.

• Configuration: Select the configuration affected by these choices.
• Signal: Select the authorizing signal to be overridden by these choices. 

• Selection: Select floors, cars, and calls singly or in blocks just as described for setting secu-
rity authorizations previously.

• Choose the operating mode or modes that will override the typically required authoriza-
tion to place a call.

• All • OBD calls • Remote calls

• Automatic door open • Emergency dispatch • Sabbath

• Attendant service • CFSS 1 • CFSS 2

• Independent service • Test mode • Shuttle service

• Click OK.
Active overrides are displayed as single letters, each corresponding to a mode:

• I = Independent • A=Attendant • 1=CFSS1 • 2=CFSS2 • D=Auto Door

• T=Test Mode • E=Emerg Dispatch • S=Sabbath • R=Remote • O=OBD

• S= Shuttle service

Note

Automatic Calls/Automatic Door Open: Under certain conditions, including certain fault condi-
tions and emergency power transfer periods, the elevator doors may need to automatically open 
or cycle open/closed at floors. Activating this override, allows the doors to open or cycle even at 
a secured opening.
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Car Calls/Passcodes
The initial screen allows you to configure passenger code timeout and lengths.

Car Calls/Passcodes/Floors
This screen allows you to assign security authorization codes for car operating panel entry.

1. Configuration: Select the configuration affected by these choices.

2. Selection: Select floors, cars, and calls singly or in blocks just as described for setting 
security authorizations previously.

3. In the dialog that appears, select the COP and the code. Click OK.

4. If you make an entry error, click Clear, then re-enter.

• Timeout between buttons: When the passenger is entering a code, if more than the num-
ber of seconds set here elapses between button presses, the code entry will time out.
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Quick Start
Operation      To place a call with the code entry security option active:

• Press a floor selection as usual. The panel buttons will begin to flash.

• Press floor buttons to enter the code.

• Correct entry will register the call. The panel buttons will return to normal.

• Incorrect or timed-out entry will not register the call. Panel buttons will return to normal.

• Repeat the process if entry was incorrect or timed-out.

Car Calls/Passcodes/Passengers      These controls allow you to assign entry codes to 
specific passengers, along with accessible floors and any special operating modes during which 
their code entry should remain valid.

When initially selected, if any passengers have been assigned a code, they will be listed in the 
window along with their code and any special operating modes associated.
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To edit an existing user, 
double-click their name. 
To add a new user, click 
Add. The Add/Edit dia-
log is largely the same:

• Name: If you are 
editing, the user 
name and Previous 
and Next buttons 
(allowing you to 
move through a list 
of users) are here.

If you are adding a 
new name, a blank 
name field and an 
Add Next button 
(allowing you to 
move to a new 
entry when this 
one is complete) 
are here.

• Select allowed 
floors and risers.

• Assign a pass code. 
(Front and Rear 
car call panels may 
use separate 
codes.)

• Select any special 
operating modes 
through which this 
access will remain 
active.

• Click OK.

• Click Send when ready to write changes to the group.

Note

Per passenger security is only available for iControl systems that have Security C functionality 
enabled. It is not a standard feature.
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Group Settings
Depending upon site capabilities and options, group modes of operation may also be remotely 
selectable.

Group Mode: Balanced
Displays and allows you to select the desired mode of operation (for iView Mode of Operation 
Configuration 1 only):

• Select the mode from the drop-down list, then click Send.

• Balanced

• Lobby Peak

• Demand Down

• Demand Up

• Auto-mode

Selection is disabled if timed operation is active through iView selection. Settings here are effec-
tive only on Operating Mode Configuration 1 and so are in force only when Configuration 1 is 
active. Details of operation for the modes in the drop-down list are set up using iView.

Flood Operation
Flood operation may be remotely activated/deactivated.
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Group Timer Table
The Group Timer Table menu allows you to create timers that automatically determine, based 
on day and time of day, the currently active configuration for Hall Call Eligibility, Parking, Park-
ing Eligibility, Mode of Operation and Security. In addition, timer tables can be used to control 
the first four Remote outputs. Depending on controller type (Central/Local dispatcher, Local/
Simplex/Swing control) some parameters are not applicable and are grayed out. Timer Tables 
are currently available for iControl only.

Features
When you select a Feature in the drop down menu, any timer that asserts that Feature will 
appear in the Timers pane so that it may be selected for editing. For example, if Hall Call Eligi-
bility is selected, any timer asserting the Hall Call Eligibility Feature is displayed and the partic-
ular hall call eligibility used is shown in the Configuration column. (The configurations that the 
timer tables select are created using parameters on the System Configuration and Security tabs 
in the iView application.) Feature selections include:

• Hall Call Eligibility
• Parking
• Parking Eligibility
• Mode of Operation
• Security (Requires password/log on. Please refer to “Manage Passwords” on page 2-17.
• Remote 01 - 04
• Active dispatching engine

Timer Details
When a timer is selected in the Timers pane, information about the timer appears in the Timer 
Details pane. (You must select a timer and click Edit to change settings, the Timer Details pane 
is read only.)
2-29

http://www.mceinc.com


Quick Start
Timers
Configured timers are displayed in the Timers pane. If timers overlap (manage the same period 
of time), the timer appearing higher in the list will have priority (control). To move a timer 
within the list, click to select it, then click Move Up or Move Down.

Add a Timer      To add a new timer to the list:

1. Click Add. The Add/Edit Timer dialog is displayed.

2. Enter a descriptive name for the timer - up to 25 characters.

3. From the Configurations pane, select the Configurations to be asserted when the timer 
is active. When creating a timer, at least one Configuration must be selected. Otherwise, 
the timer will not be created.

Controls in this area 
change depending on the 
Recurrence type selected
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4. Select the repeat frequency (Recurrence type) of the timer:

• Daily: Occurs every day.

• Weekly (Day of the week): Occurs on the specified day or days of each week. Can start 
on one day and end on another.

• Monthly (Day of week): Occurs on a day, day of the week, or multiple days each month. 
e.g., 1st, 2nd Tuesday or 3rd through the 5th.

• Yearly: Occurs on a day or days of one or more months. 

5. Click OK.

6. Click Send to send new information to the system.

To remove a timer      
1. Select a feature type from the Features drop down menu. 

2. Select a timer from the Timers pane. 

3. Click Remove. Click Send to send new information to the system.

To edit a timer      
1. Select a feature type from the Features drop down menu. 

2. Select a timer from the Timers pane. 

3. Click Edit; edit as needed. Options are the same as for adding a timer. Timers for each 
feature type are edited separately. 

4. Click OK. Click Send to send new information to the system.

To move a timer      A timers position in the list determines its priority. If two timers are 
attempting control at the same time, the timer higher in the list has priority (control). To move 
a timer: 

1. Select the timer from the Timers pane. 

2. Click Move Up or Move Down. Click Send to send new information to the system.

No valid timer: For a particular feature, i.e., Parking, Mode of Operation, Auto Stop, etc., if 
Timed is selected and there is no valid timer created (current date and time falls within the 
timer’s date(s) and times), those features will be defaulted to use Configuration 1.
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Car Recall
You can access Recall settings for individual cars in a group:

1. Select Car Recall/Group name/Car from the Remote Control menu.

2. Or, from the Detailed or Multiple Hoistway displays, right-click on the car title bar and 
select Car recall (or Car settings) from the popup menu.

If the site is properly configured and connected, and if remote recall is authorized, you may set 
conditions for and recall a selected car in a displayed group.

1. Select the floor, next, or a particular destination, to which the car should recall.
2. Set Car Call Disposition:

• Cancel car calls: Immediately cancel all car calls.

• Cancel at next car call stop: Cancel all car calls upon arrival at the next stop.

• Service existing car calls: Service all existing car calls but do not accept additional calls.

• Allow new car call registration: Service existing calls and allow additional calls.

3. Set Action at Destination Floor:

• Independent service: Put car in Independent Service upon arrival at destination floor.

• Out of service: Put car out of service upon arrival at destination floor.
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4. If Out of service option selected, set front and rear door operation:

• Keep closed: Hold doors closed.

• Keep open: Open doors and keep them open.

• Open for XX seconds: Open doors for the entered number of seconds, then close them.

5. If the car should automatically resume service after a predetermined number of sec-
onds, enable Resume service after XX seconds and set the time appropriately.

6. Click Recall to begin recalling the car (Cancel Recall to cancel, Close to close the dialog).

Car Settings
Depending upon site capabilities and options, car modes of operation may also be remotely 
selectable. The current status of each mode is displayed when the dialog is opened (i.e., Auto-
stop: Enabled).

• Auto-stop: If the Auto-stop feature is enabled in iView, you may turn it On or Off from 
iMonitor or select Timed if activation is to be controlled by Operating Mode Configuration 
1 timer-activation in iView. 

• Sabbath: Activate/Deactivate Sabbath operation. 

• Swing operation: Activate/Deactivate Swing operation. (Control inactive for Simplex car 
“groups” or if group control is currently residing on the selected car within a group (roam-
ing group operation).

• Emergency Alarm: If an emergency alarm for a monitored car becomes active, you can 
acknowledge the alarm from this dialog. In order for this acknowledgement to work, soft-
ware alarm acknowledgment must be enabled for the car through iView. Otherwise, only 
the hardware input to the car may be used to acknowledge alarms.
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Remote Outputs
Customer configured Remote Outputs may be programmed through the iView application and 
may be remotely triggered through iMonitor.

• The outputs will be named as they were in iView

• Trigger an output by simply clicking the associated button

• Active outputs are indicated by a lighted LED

• Outputs will be latching or momentary as configured in iView

Diagnostic Outputs
Allows you to view status of diagnostic outputs per car to aid in troubleshooting. Refer to the 
User Guide for the elevator controller. Select Remote/Diagnostic Outputs/Car ID.
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Network Diagnostics
Network diagnostic screens allow you to review the TCP/IP settings for controllers in the group 
and for the Remote Client PCs.

Controller Information
The Network Diagnostics screen displays LAN and System IP addresses for the controllers in 
the elevator group. Using this screen, along with the IP information in Section 1 of this manual, 
you can verify that LAN and System IP addresses are correct. Please refer to “MCE iControl 
Ethernet” on page 1-3.
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Remote Clients
The Remote Clients screen displays IP, application, and access information for the Remote Cli-
ent PCs currently connected to the group.

• Application: Displays the application being used - iView, iReport, iMonitor, or third party 
software.

• Company - the company associated with the application.

• IP Address - the IP address of the connected PC.

• Port Number - the Port assigned to the connection.

• Connection Time - the date and time of connection.

• Write Privilege - indicates whether or not the connection has been allowed write privileges

• Time Remaining - time remaining until the connection times out

• Security Access - indicates whether or not the connection has security access
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Tools Menu    
Tools menu selection allows you to make car alarm 
settings, check status of individual cars, or determine 
how the display will appear when iMonitor is next 
started.

Settings
Settings accesses alarm and car status notification 
options.

Alarm Monitoring      

• Tools/Settings/Alarm Monitoring: Opens the 
alarms setting dialog.

• Choose alarm symbol color.

• Choose whether the alarm displays solidly or flashes.

Note

For iControl, Alarm Monitoring must also be enabled through iView before it is available in 
iMonitor (Car Operations/Devices tab).
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• Choose whether the acknowledge popup is displayed automatically when the alarm is 
activated:

• Choose whether an audio alarm should sound, what that sound should be, and 
whether it should play a single time or repeat (loop) until the alarm is acknowledged:
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Car Status      Car Status allows you to enable and configure car status reporting to alert the 
iMonitor user when a car is not being dispatched by the group control, i.e., is out of service, on 
swing operation, etc.

• Enable car status: Select to activate car status reporting (operating mode reporting).

• Show pop-up: Select if you want a pop-up dialog to appear when car status changes.

• Play Sound: Choose whether an audio alarm should sound, what that sound should be, 
and whether it should play a single time or repeat (loop) until the status popup is 
acknowledged:
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Emergency Distress Alarms
When selected, Tools/Emergency Distress Alarms displays any active distress alarm from any 
car in the group. This is an alternative to automatically displaying alarm pop-ups. For iControl, 
Alarm Monitoring must also be enabled through iView before it is available in iMonitor (Car 
Operations/Devices tab).

Car Status
When selected, Tools/Car Status displays any active car status dialogs from any car in the 
group. This is an alternative to automatically displaying status pop-ups.

Additional Tools Menu Selections
• Lock positions, when selected, prevents resizing or moving group displays on the overview 

screen.

• Start With Last Set: If you want iMonitor to startup with the last displayed Connection Set 
active, make that selection here.

• Restore Overview Default Layout: To restore the default, Overview layout, select that 
option here.

• Start With Last Campus: If you want iMonitor to start up with the last campus view dis-
played, make that selection here.

• Start In Lobby View: If you wish to start in Lobby view, make that selection here.
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Help Menu
• To display version information, select About iMonitor from the Help menu. When appro-

priate, selections in the information panes are expandable to display multiple programma-
ble device software versions.

• To open online help, select Help from the Help menu.
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• Display Customization
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3

iMonitor
This section provides detailed information useful to iMonitor operators.

• Operating Modes

• Connections

• Detailed screen explanation

• Multiple hoistway screen explanation

• Display Customization
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Operating Modes
iMonitor displays the currently active operating mode for each car. An elevator may operate in 
one of many modes:

• Attendant Service: Usually initiated by a key-operated switch inside the car to allow the 
elevator to be operated by an in-car Attendant. While on Attendant service, hall and car 
call buttons remain active. The elevator will respond to car calls that have been enabled via 
different settings as specified by the car call eligibility and card reader options. During 
Attendant service, the Attendant inside the car controls direction of travel using the Atten-
dant service Up and Down switches. The Attendant can also bypass hall calls using the 
Attendant service Non-Stop switch. Door operation is typically automatic open with con-
stant pressure on the door close button required to close the doors. User settings are avail-
able to modify door operation if desired.

• Capture: The car has been placed in Capture mode using the Capture switch on the iBox. 
When placed in Capture mode, the car is taken out of public service. It will not respond to 
hall call demand or parking instructions. It will continue to service car call demand so that 
current passengers are not inconvenienced. The intent is to allow the car to service current 
passengers and then remain empty at the last serviced floor so that it may be captured for 
test, adjustment, or other non-passenger use.

• Car Panel Inspection: The car has been placed on Inspection mode using the car operating 
panel switch. Car panel inspection switches are then used to move the car.

• Cartop Inspection: The car has been placed on Inspection mode using the cartop switch. 
The cartop Up, Down and Safe switches are used to move the car.

• CFSS Mode 1 (2) at Floor: Commandeer for Special Services - The car has recalled to the 
CFSS floor and is waiting for a person to commandeer it according to the settings selected 
on the iView Configuration > Car Operation > CFSS > Mode 1 (2) tab.

• CFSS Mode 1 (2) In-car: Commandeer for Special Services - The in-car switch has been 
activated (or the car is at the recall floor if no switch). Car behavior is determined by the 
In-car settings on the iView Configuration > Car Operation > CFSS > Mode 1 (2) tab. 

• CFSS Mode 1 (2) Recall: Commandeer for Special Services - A CFSS call has been initiated 
via a hall switch. Any other hall calls will be un-assigned from the car. Any existing car 
calls will be disposed of according to the Recall settings selected on the iView Configura-
tion > Car Operation > CFSS > Mode 1 (2) tab and the car will then recall to the floor at 
which the CFSS call was latched.

• Construction Car Panel Inspection: Construction mode is enabled (iView Configuration > 
Safety tab), and the car operation panel inspection switch has been activated. However, 
while in Construction mode, the car panel inspection switches are ignored. The car can 
only be operated via the machine room or cartop inspection switches while in Construc-
tion mode.

• Construction Cartop Inspection: Construction mode is enabled (iView Configuration > 
Safety tab), allowing the car to be run on Inspection with a bare minimum of field wiring 
installed, and the cartop Inspection switch has been activated. Use the cartop Up, Down 
and Safe switches to move the car. Place the car on machine room or cartop inspection and 
operate the car with the appropriate switches.
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• Construction Hoistway Access Inspection: Construction mode is enabled (iView Configu-
ration > Safety tab), and the hall mounted Access switch has been activated. However, 
while in Construction mode, the hoistway access inspection switches are ignored. The car 
can only be operated via the machine room or cartop inspection switches while in Con-
struction mode. Place the car on machine room or cartop inspection and operate the car 
with the appropriate switches.

• Construction Inspection: Construction mode is enabled (iView Configuration > Safety 
tab), allowing the car to be run on Inspection with a bare minimum of field wiring 
installed, and the car is operating on Inspection operation. The car can be moved using 
either the cartop or machine room inspection operation switches.

• Construction Machine Room Inspection: Construction mode is enabled (iView Configura-
tion > Safety tab), allowing the car to be run on Inspection with a bare minimum of field 
wiring installed, and the iBox INSPECTION switch has been placed in the INSP position. 
Use the iBox Up, Down and Enable switches to move the car.

• EMS In-car (Switch 1 / 2): Emergency Medical Service - The EMS in-car switch has been 
activated. The car remains on EMS operation until it is returned to the recall floor and the 
in-car switch is deactivated or times out.

• EMS Recall (Switch 1 / 2): Emergency Medical Service has been activated via a hall switch 
(1 or 2). Car behavior, including the designated recall floor, is determined by the General 
settings on the iView Configuration > Car Operation > EMS > Switch 1 (2) tab.

• Fire Service In-car: In-car Firefighter Service has been activated via the in-car fire service 
key-switch. Car and door behavior is determined by the fire code settings on the iView 
Configuration > Car Operation > Fire service > Fire code > In-car tab.

• Fire Service Recall Alternate: Fire Recall Operation (Phase I), to the alternate fire recall 
floor has been initiated. Generally this is initiated by the activation of a smoke detector at 
the main fire recall floor. The car proceeds to the alternate fire recall floor designated on 
the iView Configuration > Car Operation > Fire service tab. Car and door behavior is 
determined by the fire code settings on the iView Configuration > Car Operation > Fire 
service > Fire code > Recall tab.

• Fire Service Recall Main: Fire Recall Operation (Phase I), at the main fire recall floor, has 
been initiated. Generally this is initiated by the activation of a smoke detector on a floor 
other than the main fire recall floor. Can also be initiated by the activation of the fire recall 
switch input. The car proceeds to the main fire recall floor designated on the iView Config-
uration > Car Operation > Fire service tab. Car and door behavior is determined by the fire 
code settings on the iView Configuration > Car Operation > Fire service > Fire code > 
Recall tab.

• Hoistway Access: The car has been placed on Hoistway Access Inspection mode using one 
of the hall panel mounted switches. The car can be positioned to allow access to the cartop 
or bottom.
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• Independent Service: Independent service is usually initiated by a key-operated switch 
inside the car to allow the elevator to be operated by an in-car Attendant. While on Inde-
pendent service, hall call buttons and lamps for the elevator are disabled. The elevator will 
respond only to car calls that have been enabled via different settings as specified by the 
car call eligibility and card reader options. Door operation is typically automatic open with 
constant pressure on the door close button required to close the doors. However, user set-
tings are available to modify door operation if desired.

• Inspection: One of the inspection modes (in-car, machine room or cartop) is active and the 
car is operating in Inspection mode. Inspection acceleration profile parameters are used.

• Machine Room Inspection: The car has been placed on Machine Room Inspection using 
the iBox Inspection switch. (All other Inspection modes must be inactive before Machine 
Room Inspection may be enabled.)

• Passenger: The car is operating in normal passenger mode, responding to dispatching and 
parking instructions and to hall and car call demands. Car and door operation are deter-
mined by settings on the iView Configuration > Car Operation > Passenger tab.

• Sabbath Operation: The elevator is operating in Sabbath mode initiated by a software 
command, switched input, or timer. Sabbath mode allows the elevator to operate, serving 
the building without requiring buttons to be pressed for hall calls or car calls. Car behavior 
is determined by parameters located on the iView Configuration > Car Operation > Sab-
bath operation tab.

Note

Test: Indicates that the iBox Test switch is in the Test position and the elevator is in Test mode, 
generally used to adjust or test the elevator. The elevator operates the same as in normal pas-
senger mode except that the doors are disabled and no hall calls are registered.

Note

Commandeer for Special Service is a special operating mode, much like EMS (Code Blue). Typi-
cally, a keyed switch is installed at a particular floor. When the switch is activated, the car dis-
poses of existing car calls as programmed in the iView application, and recalls to a designated 
floor. At the floor, phase II (operation in the mode) is initiated either by activation of a switch in 
the car or simply by placing a car call (as programmed in iView). A timer in iView may be pro-
grammed so that, if the car has waited at the recall floor the set period of time and phase II has 
not been initiated, the car will automatically return to the prevailing service mode.
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Connections
The Connections screen allows you to create connections for elevator groups to be monitored. 

Click to delete the connection

Click to save changes
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Connections Tab
• Connection name: Provide a logical name for the group.

• IP address: Provide the group IP address. Refer to connection information in Section 1 of 
this manual if you do not understand IP addressing. Please refer to “MCE iControl Ether-
net” on page 1-3.

• Hardware Type: iMonitor works with equipment including -

• iCue: Stand alone, group controller for iControl elevator groups.
• iBox (Alternate Dispatcher): An iControl elevator controller that is the alternate group 

controller should the iCue fail.
• iBox (Simplex): An iControl elevator control operating as a simplex elevator.
• Swing Panel (Group): A central, stand alone group controller for a group of IMC eleva-

tors.
• Swing Panel (Simplex): An IMC elevator control operating as a simplex elevator.
• Hydro (Duplex): HMC hydraulic controller functioning as a dispatcher for one addi-

tional HMC controller.
• Hydro (Simplex): HMC hydraulic controller operating as a simplex elevator.
• Traction (Duplex): PTC traction controller functioning as a dispatcher for one addi-

tional controller.
• Traction (Simplex): PTC traction controller operating as a simplex elevator.
• M3000ES: Motion 3000 escalator controller.
• M2000 (Simplex): Motion 2000 hydraulic controller operating as a simplex elevator.
• M2000 (Duplex): Motion 2000 controller functioning as a dispatcher for one addi-

tional controller.
• M Group: Motion elevator group controller.
• M4000 (Simplex): Motion 4000 controller operating as a simplex elevator.
• M4000 (Duplex): Motion 4000 controller functioning as a dispatcher for one addi-

tional controller.
• Third Party Escalator: Properly equipped third party escalator controller.

• Device ID: Assigned automatically by iMonitor when you save information entered on the 
Connections screen. Or, when defining Alternate Connections, set to the same as the Car 
ID.
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Alternate Connections
When an elevator controller or group dispatcher is acting as a backup dispatcher for a dis-
patcher or other controller, it is an Alternate connection. iMonitor always first attempts to 
establish communication with the primary connection. If that connection cannot be estab-
lished, iMonitor attempts to establish communication with the Alternate connection.

iControl Alternates      To create alternate connections:

1. On the Connections Set tab, highlight the Primary Connection.

2. Any currently defined alternate connections for that primary connection will appear 
in the Alternate Connections pane below. In other words, you must select a Primary 
Connection before any existing Alternate Connections will be visible to you.

3. To designate alternates to appear in the list, connect to the dispatcher (iCentral or iBox) 
through the iView connection.

4. On the System Configuration, Building tab, select alternate dispatchers and designate 
them to be activated manually or automatically. Auto selected cars will appear in the 
Auto-select list.

5. Move desired cars from the Local Cars list to the Alternate Dispatcher list and order 
them top-to-bottom as you want them to be activated. Save your changes.

Box shown here is on 
the iMonitor screen

This is the iView System Configuration, Building tab screen
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Back in iMonitor, set hardware type and Device ID for the alternates:

1. From the drop down, select the hardware type of the alternate.
2. From the Device ID drop down, set the ID to match the Car ID from the iView screen. 

(Car ID = Device ID)

Motion Alternates      To create alternate connections:

1. On the Connections Set tab, highlight the Primary Connection.
If any currently defined alternate connections for that primary connection exist, they will 
appear in the Alternate Connections pane below. You must select a Primary Connection before 
any existing Alternate Connections are visible or editable.

2. To create an alternate, click in the name field for the first available Alternate connection 
and provide a logical name for the connection.

3. Provide the IP address and hardware type. Ignore Device ID; it is assigned internally.

4. Click OK to save your information.
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Building Configuration / iLobby Tab
Activating this tab accesses screens that allow you to set up the iLobby display.

General
• Click on the Building Configuration tab

• Select the group to be configured for display

• Enter the number of cars in the group

• Enter the number of floors served by the group

• Enter the lobby floor for the group

• Enter the height of the cars in the group

• Show registered hall call: Enable to show the system hall call riser on the lobby display. 

• Time and Date are not yet active

• Show “You Are Here”: Enable to display a star at the Lobby floor
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Building floor heights
This screen allows you to define the floor heights so that the cars appear in the correct positions 
on the lobby display.

Per Floor Entry      Enter the height in feet up to two decimal places. (Example: 8.25 = 8 
feet, 3 inches.)

• Obtain the learned floor heights from the iView building configuration.

• Distances accumulate. For example, if the first floor is 0.5 feet and the second floor is 8.5 
feet, the third floor will be something like 16.5 feet (current floor plus preceding).

Auto Configure      Enter a starting and an ending floor, a starting value (first floor height), 
and a common floor height to increment by (say 10 feet). Click Apply and the floor heights table 
will populate automatically. You can then edit it as needed.
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Per Car Settings
This screen allows you to define offset and door times for each car.

• Bottom Floor offset: If a car does not serve the bottom floor of the group, provide an offset 
value equal to the height of the lowest floor it does serve.

• Door Opening Time: The time in seconds it takes this car to open its doors.

• Door Closing Time: The time in seconds it takes this car to close its doors.
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Detailed View Explanation
The Detailed View screen narrows the focus to a single elevator group, providing more informa-
tion per car.

• Select Detailed View/Group name from the View menu.

For as many cars as are in the selected group, you will see the following per car information.

• Operating mode: Please refer to “Operating Modes” on page 3-2.

• Group Status: Lighted = Under group control. Dark = Not in group control.

• Door position indicators: Real time door position. Blue = Rear. Orange = Front.

• Current floor: Floor elevator is at or passing.

• Current direction arrows: Animated travel direction indicators.

• Next destination: Floor of next stop.

• Preferred travel direction: Direction in which the elevator prefers to move from the cur-
rent location.

• ETA: ETA to Next destination (if a hall call).

• Rear opening call indicator: Indicates call/direction for rear hall calls.

• Front opening call indicator: Indicates call/direction for front hall calls.

Operating mode

Group status 

Door position indicators:
Blue = rear
Orange = front

Current floor

ETA seconds to next hall call

Current direction arrows

Next destination

Preferred travel direction

Emergency power status

Seismic mode status

Swing operation indicator:
Off = Not in swing
On = Swing

Rear opening call indicator

Front opening call indicator

Load analysis
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Note

The front/rear hall call indicator bands are separated as follows:

• Non-directional calls: “Hall” calls that do not imply a requested direction of travel. For 
example, CFSS calls, EMS (Code Blue) calls, etc.

• Emergency power status: 
• Normal: Car is operating under normal power.
• Run: Car is running under emergency power.
• Recall: Car is recalling to emergency power recall floor.
• Freeze: Car stopped immediately because of power loss.
• Recall next floor: Car is recalling to emergency power recall floor — designated as the 

next floor in the current direction of travel.
• Seismic mode status:

• Normal: No seismic (earthquake) activity detected.
• On: Seismic activity detected. Car operating as programmed in iView.
• Off: Seismic mode is not active.

• Load weigher status: Report of load currently in car.
• Swing operation indicator: If lighted, a special set of hall calls (a swing riser) for this car 

has been activated. The car will not respond to hall calls registered to the group.
• Sabbath operation:

• On: Sabbath operation is active. In Sabbath operation, the car will service floors as 
defined through iView in a semi-automated fashion, requiring no car calls to be regis-
tered.

• Off: Sabbath operation not active.
• Flood operation:

• On: The car is operating in Flood mode with floor access restrictions as defined in 
iView.

• Off: Flood operation is not active.
• Auto-stop:

• On: The car is observing auto-stop operation as defined in iView. Generically, auto-
stop requires that a car traveling past a specified floor pause and cycle its doors so that 
the occupants may be observed.

• Off: Auto-stop mode is not active.

Note

Displayed indicators will vary from car to car depending upon available options and operating 
modes. For example, if a car does not have Flood operation, Flood status will not be displayed.

Down hall callsUp hall calls

Non-directional calls

Blue = Rear opening

Orange = Front opening
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Multiple Hoistway View Explanation
This view provides hoistway position, call information, and more for all cars in the selected 
group.

• Select Multiple Hoistway View/Group name from the View menu.
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Multiple Hoistway View Explanation

3

Supervisor Information
The Supervisor column of the Hoistway View screen provides traffic 
mode and Estimated Time of Arrival information for the group.

• Traffic Mode: (Balanced in this example) Displays the current 
mode through which the elevator group is servicing traffic 
within the building. This mode may be selected manually, by 
timer, or automatically according to iCue analysis of realtime 
traffic conditions.

• Balanced: All elevator traffic within the building is receiving 
equal priority from the group.

• Lobby Peak: Designated lobby floors are receiving priority 
attention. Generally active during morning arrival times 
when traffic is heaviest departing the lobby for other floors.

• Demand Up Peak: Upward bound traffic is given priority. If 
assigned dynamically, made active when approximately 80% 
of building traffic is in the up direction.

• Demand Down Peak: Downward bound traffic is given prior-
ity. If assigned dynamically, made active when approxi-
mately 80% of building traffic is in the down direction.

• Auto-mode (i.e., Balanced, Lobby peak, Dmd up, Dmd 
down): The traffic mode is being controlled dynamically by 
iCue according to real time traffic analysis and learned 
building traffic patterns.

• ETA: Estimated Time of Arrival. The time, in whole seconds, in 
which iCue estimates a registered hall call will be serviced. ETA 
counts in the blue zone indicate a rear hall call. ETA counts in 
the orange zone indicate a front hall call.

• Up / Down Columns: When a hall call is placed, its ETA will 
be displayed in the Up or Down (as appropriate) hall column 
next to the floor from which the car was placed. The ETA will 
count down to the arrival of the responding car.

• Non-directional: An ETA in the left-most column indicates a 
non-directional “hall” call has been placed at this floor. Non-
directional calls are calls that do not indicate a requested 
direction of travel. For example, CFSS calls, EMS calls, etc.
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• ETA Filtering: Clicking the ETA button opens up a dialog that allows you to filter 
ETA information as desired.

• CFSS calls: Allows you to choose 
how CFSS ETA counts are dis-
played:

• Hide CFSS call data: Do not 
display CFSS call ETA.

• View CFSS 1 data: Display ETA 
and wait time data as selected 
for CFSS 1 only.

• View CFSS 2 data: Display 
ETA and wait time data as 
selected for CFSS 2 only.
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Multiple Hoistway View Explanation

3

• Hall calls: Allows you to select 
how hall call ETA counts are dis-
played.

• Hide hall call data: Do not dis-
play hall call ETA.

• View main data: Display ETA 
and wait time data as selected 
for main hall calls only.

• View AUX data: Display ETA 
and wait time data as selected 
for auxiliary hall calls only.
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Per Car
Per car, the Hoistway View 
screen provides:

• Comm status: As shown 
when communication is 
good. Separated by red 
slash and offset if com-
munication is lost.

• Car ID: Car label.

• Operating mode: Please 
refer to “Operating 
Modes” on page 3-2.

Please refer to “Detailed 
View Explanation” on 
page 3-12 for remaining call 
out descriptions.

Group communication status

Car ID

Operating mode

Current direction of travel

Current floor

Preferred direction of travel

In Group status

Next destination floorNext destination floor

Position and door indication

Non-directional call

Up car callUp car call

Down car call

Hoistway location
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Display Customization

3

Display Customization
There are options to modify the screen presentation of the iMonitor “overview” and options to 
customize the screen presentation when iMonitor is used to drive a lobby display.

Customizing the Overview
While in overview, you may click/drag the lower right corner of a group pane to resize it as 
desired. After resizing, you can drag individual cars to arrange them in any order or pattern. 
Click and drag in the top bar of a car window and drag it to a new location.

From the overview, you may customize your iMonitor display by right-clicking in the top bar, 
selecting Display, then selecting the display option:
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• Grid: Displays a reference grid behind the cars:

• Snap to grid: Causes a dragged car to snap to a grid marker when released.

• Default 1 row: Reverts the display to the traditional single row display with cars in 1, 2, 3, 
4, etc. order.

• Default single row/column: Displays cars in a numerically 
ordered row or column.

• Display cars 2 (3 or 4) per row: Displays the cars in rows of two, 
three, or four:
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Display Customization

3

Lobby Display
In the View menu, there are selections used to set up the 
display for use in the building lobby.

• Hide iMonitor border: Conceals the border surround-
ing the iMonitor display.

• Hide main menu: Conceals the toolbar menu selec-
tions.

• Hide view menu: Conceals the view selecting icons in 
the toolbar.

To reveal any hidden screen element, simply press the F5/F6/F7 shortcut key.
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